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Perangkat Lunak 
Presentasi Tingkat 

Dasar
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 Tujuan Pembelajaran:
 Hasil Belajar: 

Setelah mengikuti pembelajaran ini peserta kompeten dalam menggunakan 
perangkat lunak presentasi tingkat dasar.

 Indikator Hasil Belajar:

Setelah mengikuti pembelajaran ini, peserta kompeten:
1. Mempersiapkan perangkat lunak presentasi

2. Membuat file presentasi

3. Melakukan editing sederhana

4. Menggunakan template presentasi

5. Menggunakan gambar untuk presentasi

6. Mencetak file presentasi

7. Menjalankan presentasi
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[Ringkasan]



Mempersiapkan
perangkat lunak

presentasi
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• Identifikasi perangkat lunak 
presentasi telah terinstal dan 
berjalan normal;

• Memahami petunjuk penggunaan 
perangkat lunak presentasi;

• Identifikasi perangkat komputer 
sudah dinyalakan dengan sistem 
operasi dan persyaratan sesuai 
dengan manual instalasi;

• Penjelasan cara menjalankan 
perangkat lunak presentasi.



Persyaratan perangkat keras (hardware) untuk
menjalankan aplikasi Power Point
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Spesifikasi perangkat keras (hardware) 
yang kita miliki

Spesifikasi yang diperlukan untuk menjalankan Power Point 2019
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Klik 2 kali icon power point pada desktop komputer1

Beberapa cara untuk menjalankan Power Point
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Klik tombol windows, cari Power Point lalu diklik2
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Cari dengan memanfaatkan tombol
search (kaca pembesar) pada 
taskbar, lalu ketikan power point

Pilih power point atau langsung pilih
Open

3
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Tampilan awal Power Point 2019

Buatlah slide presentasi baru dengan memilih “New”



10Penggulung Mendatar
Tombol Peninjau Halaman

Baris Judul / Nama File Tombol maksimasi aplikasi

Ribbon

Menu

Akses Cepat
Tombol minimasi aplikasi

Tombol menutup aplikasi

Indikator halaman
slide yang aktif

Status 
Halaman

Area Slide / Dokumen

Penggulung
Vertikal

Kendali
Perbesaran

Lingkungan Kerja



ScreenTip

 ScreenTip merupakan fasilitas yang  

muncul saat kursor diarahkan ke  

sebuah tombol menu.

 ScreenTip menampilkan nama  

tombol menu beserta fungsi dan  

tombol pintasnya / shortcut (jika  

ada).
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Tombol Menu dan Tanda Panah

 Terdapat 2 (dua) jenis tombol menu yang  
memiliki tanda panah, yaitu:

1. Tombol menu dengan tanda panah  
menyatu saat kursor terarah; yang akan  
menampilkan opsi menu terkait.

2. Tombol menu dengan tanda panah  
terpisah saat kursor terarah; yang akan  
langsung mengeksekusi default action  
dari tombol menu saat di-klik atau  
menampilkan opsi lain saat tanda  
panah di-klik.
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Keyboard Shortcuts
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 Alt

Untuk menampilkan kombinasi huruf shortcut masing-masing Ribbon Tabs.  

Contoh: Alt + F adalah kombinasi untuk mengakses Tab File.

 Ctrl + F1

Untuk menampilkan atau menyembunyikan Ribbon.

 Ctrl + M

Untuk menambahkan slide kosong.

 Ctrl + K

Untuk menambahkan hyperlink.



Keyboard Shortcuts
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 Untuk daftar yang lebih lengkap silakan akses alamat website berikut ini:

 Keyboard Shortcuts pengelola file.

(https://support.office.com/en-us/article/use-keyboard-shortcuts-to-create-powerpoint-
presentations-ebb3d20e-dcd4-444f-a38e-bb5c5ed180f4)

 Keyboard Shortcuts pengontrol jalannya presentasi.

(https://support.office.com/en-us/article/use-keyboard-shortcuts-to-deliver-powerpoint-
presentations-1524ffce-bd2a-45f4-9a7f-f18b992b93a0)

https://support.office.com/en-us/article/use-keyboard-shortcuts-to-create-powerpoint-presentations-ebb3d20e-dcd4-444f-a38e-bb5c5ed180f4
https://support.office.com/en-us/article/use-keyboard-shortcuts-to-deliver-powerpoint-presentations-1524ffce-bd2a-45f4-9a7f-f18b992b93a0


Keyboard Shortcuts
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 F5

Untuk menayangkan presentasi dari slide pertama.

 Shift + F5

Untuk menayangkan presentasi dari slide yang sedang diedit.

 Esc

Untuk mengakhiri presentasi.

 Ctrl + W

Untuk menutup jendela file PowerPoint.

 Ctrl + Q

Untuk menutup program PowerPoint.
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Menu Group / Ribbon

• Ribbon adalah fasilitas berupa sekumpulan menu jalan pintas.

• Bagian utama dari Ribbon adalah Ribbon Tabs yang berisi 8 (Delapan)
menu utama yaitu: Home, Insert, Design, Transitions, Animations, Slide
Show, Review dan View.



• Menu File memuat  

perintah – perintah  

pengelolaan file  

presentasi serta  

informasi detil tentang  

perangkat lunak  

PowerPoint.

Ribbon – Tab 1: File 



• Dari menu File dapat  

dibuat file presentasi  

baru dengan beragam  

template yang telah  

tersedia.

Ribbon – Tab 1: File 
(Lanjutan)



• Menu File juga  

memuat informasi  

tentang versi  

perangkat lunak  

PowerPoint.

Ribbon – Tab 1: File 
(Lanjutan)



Ribbon – Tab 1: File
(Lanjutan)

 Bagian penting dari  
Menu File adalah  
Options untuk  
mengatur tampilan dan  
perilaku jendela  
PowerPoint.
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 Terdiri dari kumpulan menu:

a. Clipboard berfungsi untuk mengelola obyek, baik teks maupun gambar.

b.Slides berfungsi untuk mengelola lembar (slide), mulai dari membuat hingga menghapus lembar.

c. Font berfungsi untuk mengatur format huruf.

d.Paragraph berfungsi untuk mengatur format pengetikan teks.

e. Drawing berfungsi untuk membuat obyek berupa garis atau bidang.

f. Editing berfungsi untuk menyunting obyek, baik teks maupun gambar.

21

Menu Home



 Terdiri dari kumpulan menu:

a. Slides berfungsi untuk mengedit tampilan (layout) slide.

b. Table berfungsi untuk membuat tabel.

c. Images berfungsi untuk menambahkan obyek berupa foto.

d. Illustrations berfungsi untuk menambahkan obyek berupa gambar (clipart, bentuk garis/bidang, grafik
statistik, dsb).

e. Add-ins berfungsi untuk menambah plugin tambahan atau aplikasi tambahan

f. Links berfungsi untuk memasukkan tautan yang dapat diatur untuk membuka berkas pendukung
presentasi yang berupa file, program, URL, atau referensi lain yang terkait.

g. Comments berfungsi untuk menambahkan komentar pada isi presentasi

h. Text berfungsi untuk memasukkan Text Box, Header / Footer, WordArt, Tanggal dan Waktu, dan Obyek
Linkable.

i. Symbols berfungsi untuk menambahkan Karakter Khusus

j. Media berfungsi untuk menambahkan video atau rekaman suara.
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Menu Insert



 Terdiri dari kumpulan menu:

a. Themes berfungsi untuk mengatur tema dan tata letak lembar (slide).

b.Variants berfungsi untuk mengatur pilihan warna dari tema yang dipilih.

c. Customize berfungsi untuk mengatur tampilan background lembar (slide).
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Menu Design



 Terdiri dari kumpulan menu:

a. Preview berfungsi untuk pratinjau tampilan slide.

b.Transition to This Slide berfungsi untuk mengatur tampilan efek visual pergantian slide

c. Timing berfungsi untuk mengatur waktu efek visual pergantian slide

24

Menu Transitions
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Menu Animation

 Terdiri dari kumpulan menu:

a. Preview digunakan untuk pratinjau animasi tiap obyek.

b.Animations digunakan untuk memberi efek animasi tiap obyek dalam satu slide.

c. Advanced Animation digunakan untuk memberikan efek tambahan pada transisi
obyek.

d.Timing digunakan untuk mengatur waktu efek animasi setiap obyek
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Menu Slide Show

 Menu Slide Show berkaitan dengan pengaturan dan memulai tampilan slide
dalam mode presentasi, dan diselenggarakan dalam tiga Grup:

a. Start Slide Show digunakan untuk mengatur permulaan slide yang akan
ditampilkan.

b.Set Up digunakan untuk pengaturan tampilan presentasi dengan pilihan manual
atau otomatis.

c. Monitor digunakan untuk mengatur resolusi pada layar penampil presentasi.
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Menu Review

 Terdiri dari kumpulan menu:

a. Proofing digunakan untuk pengecekan ejaan.

b.Accessibility digunakan untuk memastikan dokumen Anda mudah untuk
membaca dan mengedit bagi semua kalangan

c. Insights digunakan untuk melakukan pencarian terhadap kata dari sebuah tulisan
yang ada pada dokumen

d.Comments digunakan untuk memberikan komentar pada suatu bagian teks
tetapi tidak akan tercetak.

e. Compare digunakan untuk membandingkan dan mengkombinasikan beberapa
file presentasi
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Menu View

 Terdiri dari kumpulan menu:

a. Presentation Views digunakan pengaturan tampilan slide dan pembuatan slide
master.

b.Show/Hide digunakan untuk menampilkan atau menyembunyikan Penggaris dan
Titik-titik bantu.

c. Zoom digunakan untuk mengatur ukuran tampilan pada saat pengeditan.

d.Color/Grayscale digunakan untuk mengatur tampilan slide saat pengeditan
tetapi tidak mempengaruhi hasil akhir.

e. Window digunakan untuk menampilkan dokumen saat pengeditan.

f. Macros digunakan apabila kita akan menambahkan perintah Makro, seperti
bahasa pemrograman yang tertanam pada aplikasi Powerpoint.
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Menu Format (Tambahan)

 Ketika sebuah obyek pada slide diaktifkan dengan klik, maka akan muncul Tab  
tambahan pada deretan Ribbon.

 Tab tambahan tersebut berfungsi untuk mengatur format obyek yang sedang 
aktif.



Membuat file 
presentasi

30



Create/New

1. Klik Tab File 2. Klik menu New

3. Klik pilihan jenis  
presentasi yang akan

dibuat (starting options)Ctrl + N

31

Shortcut:



Starting Options 
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Pilihan jenis file presentasi yang akan dibuat:

1. Blank Presentation; untuk membuat file presentasi dari  
slide kosong.

2. Template; untuk membuat file presentasi dari slide yang  
telah dilengkapi dengan layout, design, maupun transisi  
dan animasi.



Saving File 

1. Klik Tab File
2. Klik menu Save  

atau Save As

3. Pilih lokasi  
penyimpanan file

Ctrl + S

Shortcut:
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Saving File 
(lanjutan)

1. Tentukan nama  
file serta tipenya

2. Klik tombol
Save

Terdapat di bagian  
Format Standar File 

Presentasi
pada bahan ajar ini.

Tipe File

34



Opening A File

1. Klik Tab File 2. Klik menu Open

3. Pilih lokasi file yang  
akan dibuka

Ctrl + O

Shortcut:

Open
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Insert Slide 

1. Klik Tab Home

2. Klik tombol New Slide  
(ikon; bukan tulisan dengan

tanda panah)

Ctrl + M

Shortcut:

3. Slide baru ditambahkan
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Insert Slide (lanjutan)

3. Klik menu New Slide  
dengan tanda panah

4. Pilih layout Two Content

5. Lanjutkan  
menambah slide

untuk  
menerapkan  

masing-masing  
layout yang  

tersedia.
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Delete Slide
 Langkah untuk menghapus 1 (satu) slide:

 Langkah untuk menghapus 2 (dua) slide atau lebih:

Pilih sebuah slide dari  
Thumbnail Pane

Klik kanan, pilih Delete Slide  
atau tekan tombol Del

Slide terhapus

Pilih sebuah slide dari  
Thumbnail Pane

Tekan tombol Shift, tahan,  
lalu pilih slide lain

Lepas tombol Shift, lalu Klik  
kanan, pilih Delete Slide atau  

tekan tombol Del
Slide terhapus
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Pastikan File Anda Telah
Tersimpan dengan sering
menekan tombol Ctrl + S.
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Format Standar File
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Format Standar File
(lanjutan)

41



Format Standar File
(lanjutan)
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Format Standar File (lanjutan) 
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Format Standar File (lanjutan) 
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Format Standar File (lanjutan) 
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Format Standar File (lanjutan) 
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Format Standar File (lanjutan) 
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Format Standar File (lanjutan) 

• Default tipe file presentasi PowerPoint 2013 adalah .pptx

• Sesuaikan tipe file dengan kebutuhan penyimpanan untuk dapat  
dikelola dengan tepat.
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Melakukan editing 
sederhana
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• Menggunakan fitur-fitur
editing sederhana untuk
mengolah file presentasi

• Mengaplikasikan fitur-fitur
layout (tata letak) untuk file 
presentasi

• Men-setting fitur-fitur isian
berulang, seperti: header, 
footer, page numbering



Merancang Slide

 Slide berisi Text box, atau wilayah pada slide yang ditutupi oleh garis batas. 

 Text box dapat berisi berbagai item termasuk teks, gambar, dan grafik. 

 Ada beberapa Text box dan berukuran ikon kecil yang mewakili perintah tertentu 
seperti Insert picture, Insert chart, dan Insert Clip art. Arahkan mouse ke setiap 
ikon untuk melihat jenis informasi yang Anda dapat sisipkan. 



Layout
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 Layout Slide berisi kotak pemformatan, pemosisian, dan tempat penampung untuk semua konten yang muncul di 
slide.

 PowerPoint menyertakan layout slide bawaan, dan bisa diubah untuk memenuhi kebutuhan tertentu.
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 Layout slide standar di 
PowerPoint, memperlihatkan 
penempatan berbagai tempat 
penampung untuk teks atau 
grafik.

 Anda bisa mengubah layout slide standar yang dibangun 
 PowerPoint di tampilan Slide Master. Gambar di bawah ini
 memperlihatkan slide master dan dua tata letak Master
 untuk sebuah tema di tampilan Slide Master.



Master Slide

Merupakan fitur yang memungkinkan membuat layout untuk tampilan slide presentasi, yang nantinya
layout tersebut bisa digunakan berulang kali, 

 Ketika ingin semua slide berisi font dan gambar (seperti logo) yang sama, anda dapat membuat perubahan
tersebut di satu tempat, Master Slide, dan akan diterapkan ke semua slide. 

 Untuk membuka tampilan Slide Master, di tab View , pilih Master Slide: 

53

Master Slide

1

2
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3

4

Slide Master

Master Layout

 Ketika master slide diedit, semua slide yang dibuat berdasarkan master tersebut akan mengalami perubahan. 

 Termasuk Master Layout yang berada di bawah Slide Master
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Mengganti Font di Master Slide

Buka tampilan Slide Master, di tab View , pilih

Master Slide
1

2

Klik pada bagian Slide Master

3

Pilih Font

4

Pilih salah satu font dari list 5
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B
EFO

R
E

A
FTER

Jika Font/themes pada slide 

master diubah, maka secara

otomatis pada bagian layout pun 

juga akan ikut berubah

Setelah selesai melakukan edit, 

klik tombol close Master View 

Close, untuk Kembali ke Slide 

presentasi sebelumnya.

6



Header & Footer
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Header

Footer

Merupakan suatu area yang berada pada bagian
atas margin setiap halaman di dokumen.

Merupakan suatu area yang berada pada
bagian bawah margin setiap halaman di 
dokumen.

Fungsi

Membantu menyisipkan teks seperti nomor
halaman,judul, tanggal ,nomor halaman dan
judul penulisan.

Footer yang 
ditambahkan

Nomor
halaman
setiap
slide



Penerapan Header & Footer
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Pemberian NO halaman pada setiap slide secara otomatis

1

2

3

Pilih Tab Menu 
Insert > Header & 

Footer

Slide Number :Untuk menambahkan nomor
halaman di slide

Footer : Catatan kaki

Don’t Show on tittle Job : agar footer dan no 
halaman tidak ditampilkan di slide title



Menggunakan
Template Presentasi
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• Mempraktikkan cara memilih
template yang sudah tersedia
sesuai dengan kebutuhan

• Mempraktikkan cara
menggunakan paragraph styles 
sesuai dengan kebutuhan
pengguna

• Mempraktikkan cara memilih
font styles sesuai dengan
kebutuhan pengguna

• Mempraktikkan cara
memodifikasi styles sesuai
dengan kebutuhan pengguna



Memilih Template/Tema

Tujuan : 

 Menggunakkan slide siap pakai yang dapai digunakan sesuai kebutuhan.

 Dapat menghemat waktu sehingga dapat membuat slide presentasi menarik lebih cepat daripada membuat
dari nol.

 Template Default Microsoft

 Template download dari web penyedia template
 https://www.free-powerpoint-templates-design.com/free-powerpoint-templates-design/

 https://slidesgo.com/

 https://24slides.com/templates/featured

 Template Buatan Sendiri

60

Template Powerpoint

Sumber Template Powerpoint

https://www.free-powerpoint-templates-design.com/free-powerpoint-templates-design/
https://slidesgo.com/
https://24slides.com/templates/featured
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 Template Default Microsoft

Buka powerpoint > Tab Menu File

Klik More themes Pilih salah satu dari template diatas

1

2

3

Cara 1
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Klik Create, untuk menggunakan template tersebut
5

Contoh Penggunaan template 
6



63

 Template Default Microsoft

Buka powerpoint > Tab Menu Design

Klik salah satu themes yang sudah tersedia

untuk diterapkan di keseluruhan presentasi.

Untuk mengganti warna dari themes yang sudah

Dipilih, klik pada bagian Variant, bagian ini digunakan untuk

memodifikasi warna, tulisan , effect dan background Style 

pada themes.1

2

3

Cara 2



 Background Styles.

Jika tidak memerlukan template/tema, dapat juga dilakukan pengubahan warna latar belakang saja melalui 
menu Background Styles.

64

Pilih Tab Menu 
Design 

Pilih Slide yang 
ingin di 
modifikasi

Pilih Format 
Background atau
klik kanan pada slide 
> Format 
Background

Sesuaikan
pengaturan format 
background

Pilih untuk menerapkan
pengaturan ke seluruh
slide di presentasi

1

2

3

4

5



Menggunakan Paragraph Style
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Bullets :
membuat paragraf 

penomoran dengan titik 
bulat, atau bentuk objek 

lainnya.

Numbering : 
membuat paragraf 

penomoran dengan angka 
atau dengan huruf.

Decrease Indent : 
menggeser indentasi

halaman ke sebelah kiri 
(batas awal paragraf).

Increase Indent :
menggeser indentasi
halaman ke sebelah 

kanan.

Text Direction : 
mengubah arah 

penulisan teks dari 
kanan ke kiri

Line Spacing :
mengatur jarak 
spasi antar baris 

teks.

1

2

3 4

5

6



Penerapan Paragraph Style
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1
 Emerging trends in real estate tech

 New tech tools for retailers

 Emerging use cases for drones

 Emerging trends in blockchain

3

1) Emerging trends in real estate
tech

2) New tech tools for retailers

3) Emerging use cases for drones

4) Emerging trends in blockchain
1

)
E

m
erg

in
g

 
tren

d
s in 

real esta
te

tech

2
)

N
e

w
 tech

 
to

o
ls fo

r
retailers

2

1) Emerging trends in real estate tech

2) New tech tools for retailers

3) Emerging use cases for drones

4) Emerging trends in blockchain

5

6
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Justify : 
mengatur teks 

menjadi rata kanan-
kiri (Ctrl+J).

Convert to SmartArt :
mengubah teks penomoran 

agar berada dalam objek 
Shape sehingga berbentuk 

ilustrasi visual.

Align Text Left :
mengatur teks 

menjadi rata kiri 
(Ctrl+L).

Center : 
mengatur teks 

menjadi rata tengah 
(Ctrl+E).

Align Text Right : 
mengatur teks 

menjadi rata kanan 
(Ctrl+R).

Columns :
mengubah jumlah kolom 
teks (gaya koran/majalah 

atau kolom dokumen 
konvensional).

Align Text :
mengatur paragraf 
berada di tengah 

kotak, di sebelah atas, 
atau di sebelah bawah 

kotak.

10 11

12

13

9

8

7



Penerapan Paragraph Style

68

It is a long established fact that a reader will be 
distracted by the readable content of a page 
when looking at its layout. 

It is a long established fact that a reader will be 
distracted by the readable content of a page 

when looking at its layout. 

It is a long established fact that a reader will be 
distracted by the readable content of a page 

when looking at its layout. 

It is a long established fact that a reader will be
distracted by the readable content of a page
when looking at its layout.

7

8

9

10

it is a long 
established 
fact that a 
reader will be 
distracted by 
the readable 
content of a 
page when 
looking at its 
layout. The 
point of using 
Lorem Ipsum is 
that it has a 
more-or-less 
normal 
distribution of 
letters, as 
opposed to 

using 'Content 
here, content 
here', making it 
look like 
readable 
English. Many 
desktop 
publishing 
packages and 
web page 
editors

11



Penerapan Paragraph Style

69

MIDDLE

TOP

BOTTOM

12

1) Emerging trends in real estate tech

2) New tech tools for retailers

3) Emerging use cases for drones

4) Emerging trends in blockchain

Emerging 
trends in 

real estate 
tech

New tech 
tools for 
retailers

Emerging 
use cases 
for drones

Emerging 
trends in 

blockchain

Sesudah

Sebelum

13



Memilih Font Style
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Font Box :
memilih jenis huruf 

yang tersedia dalam 
sistem.

Font Size Box:
mengubah 

ukuran huruf.

Increase Font Size : 
memperbesar 

ukuran huruf secara 
bertahap dengan klik 

mouse.

Decrease Font Size : 
mengecilkan ukuran 

huruf secara 
bertahap dengan klik 

mouse.

Clear All Formatting : 
menghapus seluruh 
format yang telah 

diterapkan pada teks 
menjadi tampilan standar

Font Color :
mengubah warna 

huruf dari teks 
terpilih.

1

2

3 4

5

6
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Change Case : 
mengubah teks 
terpilih menjadi 

huruf besar / kecil.

Character Spacing : 
mengatur jarak

spasi/renggangan 
antar huruf.

Strikethrough : 
memberi garis 

coretan pada bagian 
tengah teks terpilih.

Underline : 
memberi garis bawah 

pada teks terpilih. 
Alternatif, 

menggunakan Ctrl+U.

Bold : 
menebalkan huruf pada 

teks terpilih. Sebagai 
alternatif, menggunakan 

Ctrl+B.

Text Shadow : 
uuntuk memberi 

efek bayangan pada 
teks terpilih.

Italic : 
membuat huruf 

miring. Alternatif, 
menggunakan Ctrl+I.

10

111213

9
8

7



Penerapan Font Style

72

It is a long established fact THAT A 
r e a d e r will be distracted by the 

readable writing content of a page 
when looking at its layout.

1 2 6

3

4

7

8

13

129

11

10



Menggunakan
gambar untuk

presentasi
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• Membuat obyek gambar pada
dokumen berdasarkan
kebutuhan pengguna

• Memilih obyek gambar sesuai
dengan kebutuhan pengguna

• Mengatur obyek gambar sesuai
dengan kebutuhan pengguna

• Menghapus obyek gambar
sesuai dengan kebutuhan
pengguna

• Mempraktikkan cara
memasukkan gambar dari file 
sesuai dengan kebutuhan
pengguna

• Memindahkan posisi obyek
gambar dalam dokumen sesuai
dengan kebutuhan pengguna



Menggambar Shape
 Ada banyak bentuk shape  yang dapat digunakan untuk mempercantik visualisasi

dan alat bantu  memperjelas slide presentasi.
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Untuk menambah shape , pilih tab menu Insert > Shapes

Pilih shape yang diperlukan

Tahan mouse untuk membentuk ukuran shape sesuai
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seleksi shape, maka akan muncul

point di sekitarnya.

Tarik kearah luar untuk

memperbesar ukurannya atau

Tarik ke dala untuk memperkecil

ukuran.

Mengubah Ukuran Shape Memutar Shape

seleksi shape, maka akan

muncul point di sekitarnya.

Putar panah searah jarum jam 

atau berlawanan jarum jam

Memodifikasi Tampilan

Shape

seleksi shape, maka pada bagian

kiri slide , terdapat toolbar yang 

dapat digunakan untuk

memodifikasi tampilan , shape 

seperti mengganti warna .

Memberi text pada shape

seleksi shape, klik kanan > 

EditText kemudian Isi Text 

tersebut.

OK



Menyisipkan gambar
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Pilih Tab Insert > Picture > This Device

Pilih gambar dari computer anda, kemudain klik insert

Sesuaikan letak gambar pada slide

1

2



Menerapkan efek artistik ke sebuah gambar
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Seleksi Gambar pada Slide , kemudian baru pilih tab 
Menu Format

Pada Tab Format, terdapat beberapa tools yang 
dapat digunakan untuk mengedit atau
meningkatkan kualitas gambar

1

2
3



Menghapus Gambar 

 Hapus gambar, seperti foto, cuplikan layar, objek gambar, atau tipe gambar 
lainnya dari presentasi PowerPoint saat Anda tidak lagi memerlukannya. 

 Terkadang gambar mudah dihapus karena berada di atas gambar lainnya, namun 
terkadang lebih sulit karena gambar berada di belakang gambar, pada Master 
slide, atau di latar belakang.
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Seleksi Gambar yang akan dihapus ,kemudian tekan
delete pada keyboard.Gambar pun menghilang

Jika ingin menghapus beberapa gambar sekaligus, 
tahan tombol Ctrl, dan klik setiap gambar yang ingin 
Anda hapus. Lalu tekan DELETE di keyboard Anda.



Menghapus gambar dari semua slide

79

Pilih Tab Menu View > Slide Master
• Di panel gambar Mini slide, pastikan Anda memilih gambar mini di bagian 

atas, dengan angka di dekat sudut kiri atas.
• Pilih gambar yang ingin Anda hapus, dan tekan DELETE.
• Pada tab Master slide , klik tutup tampilan Master untuk kembali ke 

presentasi Anda. Gambar telah dihapus dari setiap slide dalam presentasi.

1
2

3



menyusun objek dalam slide di PowerPoint
 Anda dapat meratakan beberapa objek untuk tampilan yang rapi dan profesional.
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Menggunakan Gridlines & Guides

1.Pilih Tab View , centang Guideleness & Guide
2.Ratakan manual sesuai arah garis
3.Matikan centang setelah selesai
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1.Pilih objek. Tekan Shift untuk memilih beberapa objek.
2.Pilih Format > Ratakan, lalu pilih tipe perataan:
•Rata Kiri, Rata Pusat, atau Rata Kanan
•Rata Atas, Rata Tengah, atau Rata Bawah
•Distribusikan secara Horizontal atau Distribusikan secara 
Vertikal

Meratakan Objek



Mengubah urutan bentuk, tempat 
penampung, atau objek bertumpuk di slide
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mengatur penempatan Objek pada slide sesuai dengan urutan penyisipannya; 

Karena objek yang baru saja ditambahkan berada di tumpukan paling atas. 

Misalkan terdapat dua buah Object yang bertumpuk seperti berikut

Object 1 Object 2

Kita menginginkan Object 2 berada diatas Object pertama

1 2



Membuat Tabel
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Pilih slide yang ingin Anda tambahkan tabel.

Pada tab menu Insert , pilih Tabel > Insert 
Tabel

Masukkan jumlah baris dan kolom > klik OK

1

2

3

4



Mencetak file 
presentasi
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• Mencetak file presentasi sebagai
slide dengan berbagai ukuran serta
parameter pencetakan

• Menggunakan fitur - fitur dasar
pencetakan seperti: page setup, 
printer setup, print preview

• Menjalankan file presentasi secara
slide show

• Melakukan navigasi dari satu slide 
ke slide lain.



Mencetak file presentasi
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Buka file presentasi yang akan di cetak Pilih menu File atau tekan shortcut 1 2



Mencetak file presentasi
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Pilih printer yang akan digunakan

Klik Add printer, untuk menambahkan
printer jika printer tidak ditemukan

3

4



Mencetak file presentasi
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Pilih slide yang akan diprint

Pilih Custom Range, kemudian masukkan
range(halaman)  slide di Slides box. For example, 
1,3,5-12.

Pilih Print All Sides, untuk mencetak seluruh slide.

Pilih Print Current Sides, untuk mencetak hanya
slide yang dipilih sebelum , melakukan opsi Print.

5



Mencetak file presentasi
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Full Page
-hasil cetak sama dengan apa 
yang dilihat pada monitor. 
-Print out ditampilkan per slide

Note Page
hasil cetak berupa slide per page 
,namun dicetak dalam bentuk
miniatur. Berbeda dengan format 
page slide yang menampilkan
dalam ukuran sesuai kertas yang 
digunakan.

Handout
-hasil cetak dalam satu kertas bisa
menampilkan beberapa slide 
sesuai yang diinginkan, bisa dua, 
empat, enam, dst sesuai
pengaturan.

Outline
hasil cetak berupa data yang 
ditampilkan pada kertas cetak
berupa teks yang merupakan isi
dari tiap slide.

6
Pilih jenis layout yang akan dicetak



Mencetak File Presentasi
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7Untuk mulai mencetak, Pillih Print Untuk menghilangkan tanggal saat print, 
Pilih Edit Header & Footer Di bagian Notes 
and Handouts, beri tanda centang
pada Date and Time dan hapus tanggal di 
bagian Fixed. Klik Enter.



Menjalankan
presentasi

90



• Untuk melihat tampilan setiap slide saat proses editing, dapat dilakukan dengan
mengakses berbagai view PowerPoint melalui tab menu View dan Tab Menu Slide
Show, pilihan view tersebut adalah

Menampilkan Slide untuk Editing
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View 1: Normal

Normal View: adalah tempat untuk 
mengetik dan mengedit slide. Anda 
juga dapat memindahkan slide dalam 
tab Slides pada task pane di sebelah 
kiri.



Slide Sorter View: Miniatur slide dapat
diatur pada layar dalam tampilan ini.
Anda dapat menarik dan menyusun ulang
slide, dan melihat slide sekaligus. View ini
baik digunakan untuk mengkonfirmasi
bahwa Anda memiliki semua yang
diperlukan slide dan tidak ada yang
sudah dihapus.
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View 2: Slide Sorter

View 3: Slide Show

Slide Show View: Pandangan ini
memenuhi layar komputer dengan slide
dan apa yang akan dilihat audiens /
viewer ketika mereka melihat
presentasi.



• Untuk mengatur tampilan slide saat presentasi dilaksanakan, dapat

menggunakan menu Slide Show.

• Slide dapat ditampilkan secara berurutan sesuai dengan urutan slide

ataupun ditampilkan secara acak dengan menggunakan fasilitas

hyperlink.

• Slide pun dapat ditampilkan secara utuh (seluruh slide) ataupun dapat

pula ditampilkan sebagian.

• Dapat pula ditampilkan secara berulang-ulang tanpa henti sampai kita

menekan salah satu tombol.

Menampilkan Slide untuk Presentasi
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 Jika ingin menampilkan secara urut seluruh slide
yang telah dibuat sesuai dengan urutan
rancangan tanpa ada yang terlewatkan, maka klik
Tab Menu Slide Show > Start Slide Show > From
Beginning atau menekan tombol F5 pada
keyboard.

 Yang perlu diingat bahwa default pergantian slide
ataupun animasi pada setiap obyek adalah
tombol ENTER, tombol arrow (panah) atau
tombol kiri pada mouse (mouse).
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Tampilan 1: Berurutan Tampilan 2 : Sebagian

 Untuk menampilkannya, klik menu Slide
Show > View Show.

1

2

3



 Klik Tab Menu Slide Show > Set Up
Show, kemudian pilih Show Options >
Centang Loop Continously until ‘Esc’ >
OK

 Untuk menampilkannya, klik menubar
Slide Show > View Show. Presentasi akan
ditampilkan secara terus-menerus dan
akan berhenti ketika tombol Esc
(keyboard) ditekan.

95

Tampilan 3: Berulang-ulang 1

2

3



Menggunakan presenter view

Gunakan presenter view untuk melihat note saat menayangkan presentasi show
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Pilih Tab Slide show > centang Use Presenter View > Pilih
Primary Monitor pada bagian Monitor

Untuk memulai presentasi pilih From Beginning atau tekan F5 pada keyboard

Pilih Tab Slide Show1 2

3
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Menampilkan note saat
penayangan, note hanya dapat
dilihat oleh presenter

Durasi presentasi yang sudah
berjalan

Mengakhiri presentasi

Menggeser SlideMelakukan Zoom In

Memberikan
penunjuk atau
marker pada
presentasi

Presenter View



Kesimpulan

98



Kesimpulan

 Kesimpulan 1...

 Kesimpulan 2...

 ...

 Dst

99



Aplikasi (Questions dan Latihan)

100



Pertanyaan
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 Sebutkan Menu apa saja yang ada di dalam Power Point?

 Di Menu manakah , fitur untuk menginput gambar dan shape?

 Bagaimana Langkah dalam menayangkan presentasi menggunakan
presenter view?



Latihan
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 Buatlah Presentasi seperti Berikut untuk warna dan tema bebas , untuk slide 3 ,silahkan isi dengan biodata 
diri Anda sendiri

SLIDE1

SLIDE 4

SLIDE2

SLIDE3



Evaluasi
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Evaluasi
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Tugas Tambahan
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Tugas Tambahan
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 Buatlah sebuah bagan organisasi seperti berikut, pastikan bentuk harus sama
untuk warna dan text boleh menyesuiakan.
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